
Introduction

BitMagic brings you short daily entertainment for free: not on the web but on your computer. The editions 
can be received automatically and BitMagic can be enjoyed at any convenient moment. No active Internet 
connection is required to view the editions. Use it every day or as much as you like.

The BitMagic experience will not take more than about three minutes. BitMagic will try to make you feel 
better, make you laugh, or at least grin. It is not a cartoon, nor is it a web site. It is something completely 
different. BitMagic will not only entertain you but also inform you about interesting stuff. And every week a 
new game is included, offering the possibility to compete with other users. BitMagic also includes an 
optional screensaver. All in just three minutes. Isn't that magic? It's a great little waste of time!

Proceed to the Getting Started section to ..... get started.
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Getting Started

The first time the BitMagic player is started an introduction movie gives you a quick overview. Then the 
Settings window pops up where personal information (like your name, email address and system settings) 
can be entered. The following information is required in order to start using BitMagic:

Personal Information:

· First Name 
· Last Name 
· Country 
· Email Address
· US zipcode (only when Country = US)
· Year of Birth
· Gender

Connection Information:

· Connection Type
 · Proxy Server (if you are behind a firewall)

Click the [Finish] button after entering all of the (required) information. BitMagic is now ready to go. If you 
are connected to the Internet, the BitMagic player will immediately download today's edition. The BitMagic 
icon in the system tray of the desktop will animate to indicate download progress. When the download is 
completed the icon will give an alert. Double click the icon to start your first BitMagic experience.

If the computer is offline, BitMagic will patiently wait for you to go online. The download will start as soon 



as a connection to the Internet is made. Downloads will not occur more then once a day.

The magic of automatic downloading today's edition does not work when the computer uses a third party 
dialer instead of standard Windows Dial-Up Networking. In this case editions have to be fetched manually 
every day by clicking the [Update] button in the player.

If any problems occur, please read the appropriate section of the Frequently Asked Questions (and 
Answers) on the BitMagic web site at: http://www.bitmagic.com/help/faq/

If you receive a notification that your email address is already in use, click here.



Email address already in use

Q: I get the message "Email address already in use". What happened? 

A: You have entered an email address in the Personal Information tab of the Settings window that is 
already in use in the BitMagic database. This may occur if you've previously installed BitMagic with the 
same email address. To prevent abuse, the owner of the email address is alerted. Just enter your 
BitMagic Personal Identification Number (PIN) to verify the authenticity of the address. If you do not know 
or remember what your PIN is, visit the BitMagic web site and have it delivered by email.

If you have never installed BitMagic software before but still get the "Email address already in use" 
message, someone may have entered your email address. In this case you should change your PIN, 
receive the new PIN by email and enter it. This will ensure that only you are registered for this account.



Using BitMagic
Quick overview of player and options

After installation and configuration, the BitMagic software waits in the background for a new edition to 
arrive. When the new edition is ready, the BitMagic icon will flash and an alert will sound. Doubleclick the 
BitMagic icon in the system tray or on the desktop to start the BitMagic player. It is not necessary to have 
the player active on the desktop all the time. 

The BitMagic Player
The player is used to play the BitMagic editions. Any current edition can be viewed and enjoyed until a 
new edition arrives. The player is fired up by clicking the BitMagic icon in the system tray or on the 
desktop. That's all it takes to enjoy the BitMagic experience. The player has some nifty extra options 
available through special buttons.

Files 
Any movie of the current BitMagic edition (including the commercials) can be selected to either save it in 
your local archive for future enjoyment or to send it to a friend that might enjoy viewing the specific movie. 
Saved movies can be played again from the local archive. Movies are also copied to your local archive 
whenever a *.bm file is doubleclicked on in the Windows Explorer or opened from the BitMagic web site.

Settings window
In the settings window, personal information and the BitMagic options can be entered. Examples: Set 
BitMagic screensaver on or off, set the Connection Type (permanent or modem) or configure the settings 
for a proxy server.

Screensaver
If the BitMagic screensaver is selected, the daily content will liven up your screen during breaks. Some 
intriguing one-liners or fortune cookies will also appear. The screensaver content gets refreshed when 
new BitMagic editions arrive.

Status window
Check what the BitMagic software is doing right now by viewing the status window. See the progress of 
the download. The window may appear and disappear automatically if configured that way. 



Using BitMagic
The BitMagic Player

The BitMagic player features a main window and several buttons. 

Main Window
The main window is used for displaying BitMagic editions or selected movies. The editions are divided 
into parts covering different area's including commercials. Some movies are to be viewed only. Other 
movies require interaction like clicking. Clicking on a web address (URL) will result in opening a new 
window in your default web browser.

Buttons
[Menu]: View the table of contents of today's edition and see any movie of the current edition by clicking 
the title. Or play the weekly game and try to beat those high scores.

[Pause]: Click this button to operate the pause function. Click it to pause viewing temporarily, click again 
to resume playing. Resuming means the current movie will run again from the start. 

[Replay]: Click this button to replay the current edition from the start.

[Mute]: Click this button to mute all sounds. Hit it again to get your audio back. NOTE: the mute button 
will mute ALL sounds including that of other applications. When closing BitMagic, it will restore the mute 
setting to what it was before BitMagic was opened.

[Files]: This will open a window where selected movies from the current edition can be saved into your 
local archive or be sent to a friend.

[Settings]: Set and change personal information and system properties. The system properties include 
the Connection Type of the BitMagic player and the optional HTTP proxy server used to speed up 
retrieving the daily editions.

[Update]: If you make modem connections that do not use the standard Windows Dial-Up Adapter, 
BitMagic will not be able to automatically detect the start of an Internet connection. In this case, new 
editions have to be retrieved manually by clicking the Update button. 



[Minimize]: Minimize the player into the task bar. When minimized the BitMagic player automatically 
pauses playing and waits to be reopened. It will resume playing at the beginning of the interrupted movie.

[Help]: Displays an instructional screen with an overview of the main functions. Click on More Help to get 
to the file you are now reading.

[Quit]: The BitMagic player will vanish from the desktop for as long as you wish. To fire up the player 
again double click the small icon in the system tray. Or double click the BitMagic icon on the desktop. Or 
double click any other BitMagic logo in sight. 



Using BitMagic
The Settings Window

The Settings window consists of a number of tabs to enter Personal information, to configure your 
Internet connection, to tune the way BitMagic operates, or to change the look and/or sounds of the 
BitMagic player. Click on one of the links below to get specific information on each option. This will open 
up a new window where they can be browsed using the "<<" and ">>" buttons.

Personal Information Tab

Connection Tab 

Advanced Settings Tab 

Skins Tab 

Sounds Tab



Required: BitMagic asks for certain information in order to create a personal account. Some of these 
fields are required others are optional. The required fields are: First name, Last name, Country, E-mail 
address, US zipcode (only if Country = US), Year of Birth and Gender. Whenever the e-mail address 
changes, just replace the contents of the E-mail address field with the correct information. The new 
information will be submitted automatically to BitMagic (Internet connection required).

Optional: BitMagic includes commercial information in the daily editions in order to guarantee some 
amount of food to the people who created BitMagic. To make advertisers happy and serve the users, 
some of the personal information is used to match this commercial information with personal interests. 
This will benefit BitMagic, our advertisers and the user (not necessarily in that order). Please complete 
this field to receive commercials matched to your interests.

Junkmail: BitMagic wants to keep users informed on an irregular basis about new versions of the BitMagic 
software and other exciting stuff. The emails will be sent to the email address specified in the Personal 
Information section. If you do not want to receive this information, just uncheck the "Keep 'em coming!" 
option. 



Connection Type: BitMagic supports two types of Internet connections. These types of connections are: 
Permanent and Modem connection. Select the one that matches your setup. 

Permanent connection (LAN, Cable modem): Select this option if the computer has a direct connection to 
the Internet (and doesn't connect through a regular modem). Usually there is a direct connection on 
computers used at companies, universities, or government offices. A permanent connection is also 
available with certain cable modems. 

Modem connection (Analog, ISDN):    Select this option if    connection is made through an analog modem 
or ISDN card. Dialers provided by Microsoft in Windows 95/98 or Windows NT4 will enable BitMagic to 
automatically detect an Internet connection and download new content when available. Third party dialers 
do not provide this option and BitMagic will not be able to detect the Internet connection. This means that 
editions need to be retrieved manually by clicking the [Update] button: Start the connection, fire up the 
BitMagic player and click the [Update] button. 

Proxy Server: A proxy server caches content at your ISP to reduce network lag time. An example of a 
proxy hostname is 'proxy.provider.com'. If you use a proxy server, verify the proxy settings in your 
Microsoft Internet Explorer or Netscape Communicator settings. The name of the proxy server used 
should be the same as listed in these environments. If you're not sure whether you use a proxy server, 
contact your ISP or network administrator. You may also let BitMagic use the proxy information found in 
the Microsoft Windows Control Panel. Uncheck this box if you want to override these settings.

You can find your HTTP proxy server information here (if it applies to you):



For Microsoft Internet Explorer 4.x viewers: 

· Click on the View menu, select Internet Options. 
· Click on the Connection tab. 
· Notice the proxy server information. 
· Click on the Settings button. 
· Copy the HTTP proxy server information and port number. 

For Microsoft Internet Explorer 5.x viewers: 

· Click on the Tools menu, select Internet Options. 
· Click on the Connections tab. 

 · Select the appropriate dial-up entry and Click Settings. 
· Notice the proxy server information. 
· Copy the HTTP proxy server information and port number. 

For Netscape Communicator 4.x viewers: 

· Click on the Edit menu, select Preferences, 
· Select the Advanced category and then Proxies. 
· Notice the Manual Proxy configuration. 
· Click on the View button. 
· Copy the HTTP proxy server information and port number. 



Autoshow BitMagic player: Select this checkbox to start the BitMagic player automatically each time a 
new edition is downloaded. This may however interfere with your current work but on the other hand will 
give rapid and instant satisfaction. If this feature is disabled, BitMagic will flash the icon in the system tray 
and give a modest audible signal to indicate that a new edition is available. To view the new edition, 
double click the flashing icon or the BitMagic icon on the desktop.

Autoshow status window: BitMagic can show a status window while downloading a new edition. A 
progress bar indicates the percentage completed and a status box shows information about the volume 
(Kbytes) that has been downloaded. Uncheck this box if you do not want to see the status window.

Launch BitMagic at system startup: This option is required to fully automate the receiving of new editions. 
BitMagic will be activated at startup of the computer and the BitMagic icon appears in the system tray. 
Don't worry: This option requires very few resources so it won't interfere with other processes on your 
computer. The option enables BitMagic to detect and retrieve new editions – when available - whenever 
there is a live connection to the Internet.

Use BitMagic screensaver: BitMagic can show parts of the current edition as a screensaver. Selecting this 
option makes BitMagic the current screensaver. Deselecting it sets the screensaver to none. 

Use content lock: Content lock is used to prevent unauthorized display of BitMagic content. As a result 
BitMagic will ask for your PIN before displaying any content, but only once during each session. 
Whenever the player is closed and re-opened, the BitMagic PIN will be required again. De-activate 
content lock by deselecting the 'Use content lock' checkbox. Enter your personal BitMagic PIN to 
deactivate this feature.



Display quality: BitMagic uses the best display quality available on the computer by default. With a high-
end configuration BitMagic displays its content in high quality, a low-end configuration will use low quality. 
Using BitMagic on a "medium-end" configuration however may result in switching between high and low 
quality display of content. To prevent this possible annoying effect select either `always use high` or 
`always use low` display quality.



The Skins tab allows you to modify the BitMagic player to match your personal style. It is possible to 
change the skin of the BitMagic player, but also the skin of the BitMagic screensaver.

Player Skins: BitMagic offers different so-called skins to change the look of the player. A skin is the 
graphical stuff wrapped around the player. In order to change the skin of the player place the new skin file 
in the ..BitMagic\Skins directory of the BitMagic application. It will now show up in the Skins list. Select the 
preferred skin and click [OK]. This will activate the new skin. It is not possible to delete the Default skin.

Screensaver Skins: You can also change the skin of the BitMagic screensaver. In order to change the 
screensaver skin, hit the [Browse] button and locate the bmp or jpg file of your choice. Select it and hit 
[Open]. Then click [OK] to activate it. You will not notice the change of course until the screensaver kicks 
in.

Skin Download: You can download other player and screensaver skins from the BitMagic website at:
http://www.bitmagic.com/download/skins/



The Sounds tab allows you to modify the BitMagic player to match your personal style. It is possible to 
change the sound that corresponds with a certain BitMagic event or change the behaviour in screensaver 
mode. The player events are:

BitMagic Close
BitMagic Open
Button Click
Error
New Content
Snooze
Snooze End

Player Sounds: In order to change the sound corresponding with a certain event, first select the event 
from the Event list box and then browse to the preferred wav file. Click the [OK] button after changing 
some or all of the events. The new setting will be saved and activated. Or save the created sound 
scheme in order to activate it later. It is not possible to delete the Default and No Sound sound schemes.

Screensaver Sound: The screensaver option turns sound on/off. The default setting is: sound off. NOTE: 
checking this box will mute ALL sounds during screensaver mode, also from other applications.



Using BitMagic
The Status Window

Download Status 
The download status displays information pertaining to the current download of today's edition. A progress 
bar is shown as well as a status box with information about how many bytes have been received at what 
speed.

[Cancel Download] Button 
Clicking this button cancels the download of today's edition. To resume the download click the button 
again. To save time only movies of the new edition that have not been downloaded will be retrieved. 

[Hide] Button 
This hides the status window. View it again by right-clicking the BitMagic icon in the system tray and 
selecting 'Show status window'.

Do not show again: If you do not want the status window to automatically appear and disappear, check 
this box. You will never see the status window again until you reconfigure this feature in the Advanced 
Settings tab of the Settings window. 



Using BitMagic
The Files Window

Local Files
Send BitMagic movies to a friend to share a moment of pleasure or save movies for future enjoyment. 
Click on the [Files] button on the player to do this. A window will open and display all the items in the 
current edition. Select a movie and click the [Play] button in order to make sure the right movie is 
selected. 
 
To share the BitMagic experience with a friend, select a movie and click the [Mail to] button. This will 
automatically create a new message in your default email client (MAPI compliant mail program required). 
The movie will be attached to the message and is accompanied by an informative text to tell the recipient 
how to view it. Select "Send as MiniMagic executable" to send the item as a MiniMagic file, or select 
"Send as BitMagic file format" to send the *.bm file itself. In the latter case, the recipient will need to have 
BitMagic installed.

If your friend does not have BitMagic installed you can send him/her a MiniMagic instead of just the *.bm 
file. A MiniMagic is a small program that plays a particular BitMagic movie without the need of having 
BitMagic installed. This way, you can be sure that your friend can view the movie at any time. To create a 
MiniMagic, select an item and click the [MiniMagic] button. This will create a MiniMagic with the name of 
the selected item and is placed in the MiniMagic directory. To send the newly created MiniMagic, select it 
from the MiniMagic directory and click the [Mail to] button. NOTE: you cannot create MiniMagic's from 
certain items such as BitGame or video items.

To save a movie into your local archive, select the movie from the current edition and click the [To 



Archive] button. This will copy the file into the ..\BitMagic\Archive directory on your hard disk. You can 
access your saved movies by selecting the archive directory. Movies in the ..\BitMagic\Archive directory 
are never automatically deleted, so you'll have to delete them manually. The Files window uses a 
Microsoft Windows Explorer style interface so that you can; create and delete (sub)directories within your 
local archive, use multi-select with the SHIFT and CTRL keys to delete items, drag-and-drop items from 
one directory to another and right-click items to trigger more options.

Central Archive
BitMagic has an archive function that allows you to view past items. You can download previous movies 
from the BitMagic web site when they are not available in your local archive. Just go to the central archive 
section on the web site by clicking on the link in this window, find the desired movie in your web browser 
and click on it.

Choose `open` if the browser asks to either save or open the file. BitMagic will download the movie, save 
it to the local archive and play it automatically. BitMagic movies will also be saved to the local archive if a 
*.bm file is double clicked or saved from the Save window.



Using BitMagic
The Screensaver

Screensaver content: 
The BitMagic screensaver shows specific items from the current edition when your computer is inactive. 
To end the screensaver just press a key or move the mouse.

Screensaver option: 
The screensaver option turns sound on/off or let you change the screensaver background (640x480 
bitmap). The default setting is: sound off. NOTE: checking this box will mute ALL sounds during 
screensaver mode. Screensaver options can be modified in the following way:

· Right click on your desktop. 
· Choose Properties from the menu. 
· Select the Screen Saver tab. 
· Under Screen Saver choose "BitSaver". 
· Click "Settings". 
· Apply changes. 
· Choose OK.

Alternatively, you can also change these settings in the Skins and/or Sounds tab from the Settings 
window in the BitMagic player.



This bar shows the download progress of the new BitMagic edition. It also shows the number of bytes 
received and the download speed.



Select the industry you work in from the list.



Check this box if you want to use the screensaver from BitMagic. Unchecking it sets your screensaver to 
none.



Check this box if you want to lock the display of BitMagic content with your BitMagic PIN.



Click this button to cancel the download of the new BitMagic edition. Click the button again to resume.



Enter your email address here or select one from the list.



Enter your year of birth here (4 digits).



Select your gender from the list.



Click this button to hide the status window from sight.



Enter your proxy host here (in the form of proxy.provider.com). Consult your network administrator or ISP 
if you do not know.



Check this box if you want BitMagic to run in the background. This is neccesary for automatic download of 
new content. It is recommended that you leave this box checked.



Check this box to turn off sound playback during screensaver mode. BitMagic will restore all volume 
settings to their previous values upon leaving the BitMagic screensaver.



Check this box if you want BitMagic to open automatically whenever a new edition arrives.



Check this box if you want to see the status window whenever BitMagic is sending or retrieving data.



Enter your BitMagic PIN here. Follow the link below if you do not know your PIN. You can get it there.



Select the country you live in from the list.



Click this button to play the item you have selected.



This is a combined window. It shows archived items, created MiniMagic's or the current edition based 
upon the folder you have selected in the folder list to the left of this window.



Check this box if you want to use a proxy server to download BitMagic editions faster.



Click this button to delete all items from the current directory.



Click this button to mail the item you have selected to a friend.



Select this option if you want BitMagic to display its content in the best quality possible on your system.



Select this option if you want BitMagic to display its content in low quality only.



Check this box if you do not want to see the status window again.



Click this button to delete the item you have selected (if button says: Delete) or send it to your local 
archive (if button says: to Archive).



Select this if you use a modem or ISDN card to dial into an ISP.



Select this if you have a direct connection to the Internet such as a LAN connection or cable modem. (you 
do not have to dial into an ISP).



Select this option if you want BitMagic to display its content in high quality only.



Check this box if you want to use proxy server information as found in the Microsoft Windows Control 
Panel. Uncheck if you want to override these settings.



Enter your first name here.



Enter your last name here.



Check this box if you want to receive information from BitMagic.



Enter the path and filename of the bitmap you want to use as screensaver skin for BitMagic or hit the 
Browse button.



Enter the proxy port here. Consult your network administrator or ISP if you do not know.



Click this button to create a MiniMagic from the selected item. Note: you cannot create MiniMagic's from 
certain items (such as BitGame or video items).



Click this button to browse for the BMP or JPG file you want configured for the screensaver skin.



This window shows the amount of harddisk space your local BitMagic archive is using.



Click this button to browse for the WAV file you want configured for the selected event.



These are the BitMagic events you can configure a sound for.



Click this button to copy the item you have selected to your local archive.



This is the file name of the WAV file that is configured for the selected event.



This is a list of items that make up the current BitMagic edition.



Click this button to play the WAV file that is present in the File Name field.



These are the BitMagic skins you can use for personalizing your player. Select one and click OK to active 
it.



Click this button to save your current sound scheme under a new name.



This window shows the folder list. Select the Archive, Current Edition or MiniMagic folder to see its 
contents.



Click this button to create a new folder in your local archive.



This is the name of the active BitMagic sound scheme.



Click this button to delete the selected sound scheme. Note: you cannot delete the Default or No Sounds 
sound schemes.



Click this button to delete the selected skin. Note: you cannot delete the Default skin.



Click this button to delete a folder in your local archive. Note: the directory must be empty.



Enter your Zipcode here (5 digits, applies only when you have selected United States in the Country 
field).



This is the info that corresponds with the BitMagic skin you have selected in the Skins window.



This is the window where all BitMagic editions are shown.



This window shows information about the item that is currently playing.




